MEFIRS Report Writer Fire Report Hints

**Standard Reports** (found under the “Tools” tab)

**These are only available to Fire Agency Administrator and Fire/EMS Agency Administrator permission groups and were created by Image Trend.**

**To set up your agency so these reports can be used, make sure:**

1) You have put Payroll ID and Personnel ID numbers into each user’s Employment tab in their account.
2) When you set up your agency locations under the “Resources” tab, you have filled in the number field in each location’s setup (this allows it to appear under Primary Station in the Incident report so you can choose it)
3) Choose a Primary Station in every Incident report, so the data can be used in the reports below.

*To get the best results from these Standard Reports, only change the date range fields and leave the other fields blank if you want to get results for all users.*

**Call Attendance Report:** Tracking a person's incident attendance by station. This report includes users that have a Personnel ID # and an Agency Location in their Employment tab, and a Primary Station has been chosen in an Incident report.

**Call Percentage Standard Report:** View call attendance for your department's personnel by station, against the total number of calls for that station and all stations. The report shows call percentages for your department's users who have a Personnel ID # and an Agency Location in their Employment tab, and a Primary Station has been chosen in an Incident report.

**Payroll Standard Report:** View payroll hour information for your department's personnel based on the fire calls, training and activity events they attend. You can choose from a “Detailed” or a “Summary” format. The report includes calls, training and activities that match the date range and incident filters. This report only includes personnel that have a Payroll ID and a Personnel ID # in their Employment tab and who are listed as attendees in an Incident report that has a Primary Station chosen in it.

---

**Report Writer Reports**

**Everyone who has access to Report Writer has a section in it called “My Reports” on the top left side of the screen. Within that section is a folder called “My Favorites”, and this is where any reports you save in Report Writer will go.**

**When you have generated an Image Trend or FMO report, you can save it to your “My Favorites” folder by going to the Actions tab at the top of the page and in the dropdown menu, choose Save As, and rename it what you want to call it. **

**Suggestion:** after you save the report, go into the Actions tab and choose
**Rename/Change Properties.** Then make sure the setting under **Visible to Everyone** is set to **NO** (otherwise everyone in MEFIRS will be able to see your report and we will have a bunch of reports cluttering up people’s folders). Further down the page, you can choose specific people so they can see the report in their “Shared Reports” section.

**If you want to Schedule a report, so it will be emailed to you on a regular basis, go to the Actions tab at the top of the page in the report and, in the dropdown menu, choose **Schedule Report.** When the screen opens, click the **Add** button at the lower left side of the screen. Another window opens, where you can schedule how often you want the report; the date range within which you want the report sent to you; the format you want; the subject line and email message you want included in the email this report will be attached to; and if you want any other people to receive this scheduled report.

**You can export a generated report by going to the Actions tab at the top of the page and, in the dropdown menu, choose Export and then chose PDF or DOC or any other format you want. When the report opens in your chosen format, use File-Save As to choose where you want the exported report to be located on your computer.**

---

**Reports in the FMO NFIRS reports folder under the Shared Reports section:**

**FMO AFG grant EMS ALS and BLS response report:** provides information for AFG grant applications on how many ALS and BLS responses were done within the chosen date range.

**FMO AFG grant Incident Type and Acres Burned Summary:** provides call Incident Type totals for the AFG grant application sections titled “Call Volume for Fire Department” and “Call Volume for Fires”, as well as the total acreage of all vegetation fires, for the chosen date range.

**FMO AFG grant Mutual Aid report:** summarizes Mutual Aid Given/Received for AFG grant applications, for the chosen date range. The report criteria codes are Automatic Aid Given, Automatic Aid Received, Mutual Aid Given and Mutual Aid Received.

**FMO Apparatus Activity** shows how often specific apparatus were used for incidents in the chosen time period.

**FMO Apparatus Average Time in Minutes from Dispatch to Enroute** provides an average apparatus response time in minutes by month and year for the selected time period.

**FMO Apparatus and Personnel for Incidents** shows the Apparatus and Personnel that responded to incidents in the chosen date range. This report is sorted by Incident Date and then by Incident Type code.

**FMO Average Response in Minutes Alarm to Arrival by Incident Type** shows the average response time in minutes by Incident Type code, within the chosen date range. “Response Time” is from Alarm to Arrival on Scene.

**FMO Average Response in Minutes Alarm to Arrival by Incident Type-No Mutual Aid** shows the average response time in minutes by Incident Type code, within the chosen date range. “Response Time” is from Alarm to Arrival on Scene and the Mutual Aid field is set to “None”.

**FMO Average Response in Minutes Alarm to Last Unit Cleared by Incident Type** shows the average response time in minutes by Incident Type code, within the chosen date range. “Response Time” is from Alarm to Last Unit Cleared.
FMO Average Response in Minutes Alarm to Last Unit Cleared by Incident Type-No Mutual Aid: shows the average response time in minutes by Incident Type code, within the chosen date range. “Response Time” is from Alarm to Last Unit Cleared and the Mutual Aid field is set to “None”.

FMO gauge report-Average Building Fire Apparatus response time for 2020: this is an analytical chart showing the average response time from Alarm to Arrival for building fires (Incident Type code 111). This can be saved to a department’s folder so the department’s time can be calculated. Year is set to 2020.

FMO Incident List: lists information on Incident Date, Incident Number, Incident Type, Full Street Address, City, and Member Making Report for reports done within the chosen date range.

FMO Incident Type Report (Summary): summarizes Incident Type codes and Total Property and Contents Loss for the chosen date range. You can fill in just the Incident Date/Time and Agency Name fields if you want an overall report for your department. Use the other filters if you want a report that contains specific information from those fields.

FMO Minutes From Alarm Time to Arrival Time: lists incidents with the amount of time that elapsed between the Alarm time and the Arrival Time.

NFIRS Incidents by Day of Month and Incident Type: summarizes the Incident Type codes that appeared on fire reports for every day of the month within the chosen time range.

NFIRS Incidents by Day of Week and Incident Type: summarizes the Incident Type codes that appeared on fire reports for every day of the week within the chosen time range.

NFIRS Incidents by Hour of Day and Incident Type: summarizes the Incident Type codes that appeared on fire reports for every hour of the day within the chosen time range.

NFIRS Incident Type Categories and Codes: lists the NFIRS Incident Type codes available in fire reports, including state Plus-One codes.

Reports in the FMO Training & Activity Reports folder under the Shared Reports section:

FMO Training/Activity attendees and hours: This report shows training and/or activities within the chosen time span. It lists attendees, if they have been paid, what their pay rate is, the total amount of pay owed for the event, and the total # of hours that will be paid per event.

Reports found in the Fire Annual Survey folder under the Image Trend Reports section:

A report that will pull data for the NFPA© Annual Survey:

- Choose the report called “Annual Survey for NFPA” (it should be the first one in that folder)
- Choose the fire department
- Choose the date range for the report

** Generate the report by clicking on the button at the lower left side of the page
Reports found in the Fire Call Information folder under the Image Trend Reports section:

Note: you may get better results from the Standard Reports I described in the first part of this document

Summarizing the # of incidents each person has responded to by month:

- Choose the report called “Calls by Person by Month”
- Fill out the date ranges (example: from 1/01/2018 to “today”)
- Choose the fire department
- If you want a summary for all personnel in the department, and not just for one person, leave the “Apparatus Personnel Full Name” fields UNCHosen

** Generate the report by clicking on the button at the lower left side of the page

A report for the previous month for each person on the roster: listing incident dates, incident #s, # of hours, total pay, pay per incident, and # of incidents

- Choose the report called “Compensation Report”
- Choose the fire department

** Generate the report by clicking on the button at the lower left side of the page

---

Hints for Creating Your Own Reports

** remember the Help/University has extensive information on creating reports in the “Report Writer/Standard Reports” folder under the “Contents” tab.

Transaction reports

When creating a new transactional report, choose the dataset you want (example: Fire Incidents) and then work from left to right across the top of the page when the setup screen opens.

Columns tab- this is where you choose the fields you want in your report. Many of the fields that are in the NFIRS Fire report are found by typing “Basic” in front of the name because the data pulls a lot of data from the Basic module of the report (example: “Basic Incident Day of Week Number and Name”). Use keywords that show up in other modules of the NFIRS report if you need to find them (example: if you need a column for codes on fire area of origin, try looking for “Fire Area”). Keep in mind what TYPE of data you will be needing in the final report when you set up these columns. For example, if you want to look for data just for Mondays and Wednesdays, use the field named “Basic Incident Day of Week Number and Name” because it has a number embedded in the field, so you can use that number when you set up your Criteria requirements.

** Note: if you want to search for Supplemental Question data from your department, enter “SQ” in the Columns search field. If you want to search for Worksheet data from your department, enter “WS” in the Columns search field. A field won’t show up in the Columns fields until someone has put data into it.
Display tab- This is where you can set up counts or averages, and do some formatting, for each field you have chosen in the Columns tab. You can also change the label of the field to shorten it up or modify it when it displays in the report.

Grouping tab- This is where you choose how the fields will display in your report. I find it helpful to sketch out how I want the report to look (what fields are going to be nested under other fields). For example: if I want a report to show the days of the week, and then the hours of the day (in military time) under each day of the week, I would set up the grouping in the following order in the right-side box:

Basic Incident Day of Week Number and Name  
Basic Incident One-Hour Range of Day 24

Sorting tab-if you need to arrange the fields in an additional sort pattern. I often skip this tab and go directly to the other tabs, and run the report as I go to see if it is set up how I want. If it needs additional sorting, then I will play around with this tab.

Criteria tab- The criteria are set in stone, so whatever parameters put on the data here WILL be searched every time you run the report. This is where “thinking ahead” when you chose your Columns will help you with constructing a query on what you want to see in the report. I have attached a screenshot in Appendix A at the end of this document that shows a Criteria page for a nested transactional report I did for Dedham, which illustrates some of the items I mention below. The report looks for all fire incidents that happened Monday through Friday from 8 am to 5pm.

If you are going to use the report for just your department, have “Basic Fire Department ID FDID” in the list and make it equal to your department’s FDID number.

If you want to select certain days of the week to do a report on, make sure you chose a field when you set up your Columns that has a number in it. When you look at the attached screenshot, since I had to use a field that had a number in it (so I could tell the criteria specifically which days of the week I wanted), when I chose the columns for the report I chose the “Basic Incident Day of Week Number and Name”, so the field would have a number in it (1 for Sunday, 2 for Monday, etc.). Then I set up the criteria with “Or” between each number selection, so I could capture any reports that have any of the numbers of the days of weeks I wanted. The Image Trend instructions say to use parentheses to clump together a batch of criteria that go together. That’s why the criteria for the days of the week have a beginning and ending parenthesis around the group.

The hours of the day were a bit more challenging, but I realized that using the field called “Basic Incident One-Hour Range of Day 24” would give me a 24-hour clock to use to find reports done in certain hours. From other reports I’ve done, I know the format is “00:00:00”, so I had to create criteria that would contain these hour times. However, it seems that using the “Contains Any” operator is the one to use for times, because the system will look for any reports that have hour 08,09, etc. in them, which also captures the minutes and seconds in a report’s Alarm time. I had to use the OR operator so it would search for any reports that contained any of the hours I chose, and this group has parentheses around it to let the system know this is another group of criteria that go together.

Filters (at the bottom of the Criteria tab)- this is where you can put fields that need to be filled in each time you run the report. I often put “Basic Incident Date Time” in the right-hand box, so I can search for any span of time (months, quarters, years) I want when I run the report.
**Additional Options tab** - this is where you can tweak report settings, like headers and footers. Under the “General Options” setting, I would keep the “Default Open Page” set to *Columns*, rather than *Report Results*. When you choose *Columns*, it allows you to look at the tabs across the screen, so you can adjust the content if you want to. If you choose *Report Results*, people just see the *Filter* field(s) to enter and then the report runs-and you can’t tweak the information in the tabs.

**Actions tab** - This is where you can save a report or schedule it. Under the “Rename/Change Properties” section, you can change the report’s name and description, export it in a different format, or print it. Under the section called *Visible to Everyone*, if you leave the YES button chosen, everybody in the MEFIRS system will be able to view your report. If you choose NO, the report will be restricted just to you and then you can go down to the bottom of the page and search for crew members to select so they can also view the report.

**Analytical Tabular reports**

These reports are set up like spreadsheets. Choose the dataset you want (example: *Fire Incidents*) and then work from left to right across the top of the page when the setup screen opens.

Under the “Design” tab:

**Basic Options** - you choose the measure you want within the report’s “cells” (average or sum). Then you pick what you want to query for the rows and columns (for example, certain Incident Type codes for certain years).

**Filters** - this is like the Criteria in a Transactional report: choose the parameters you want to system to use when querying the data. You can set multiple filters for a data field, using “AND” or “OR” operators.

**Additional Options** - this is where you can add a report title and adjust the page orientation.

“Actions” tab: this has the same abilities as in the Transactional report, except you can’t schedule these reports.

**Analytical Chart reports**

These reports provide visual representations of data, including pie, scatter or column choices. Choose the dataset you want (example: *Fire Incidents*) and then work from left to right across the top of the page when the setup screen opens.

Under the “Design” tab:

**Basic Options** - you choose the type of chart you want to use. Depending on the type of chart you choose, additional fields will appear so you can choose X and Y coordinates for your data. Some of the fields will be restricted to “averages” and “sums”, depending on the type of chart you choose.

**Additional Filters** - this is like the Criteria in a Transactional report: choose the parameters you want the system to use when querying the data. You can set multiple filters for a data field, using “AND” or “OR” operators.
**Additional Options** - this is where you can add a report title and adjust the page orientation.

“**Actions**” tab: this has the same abilities as in the Transactional report, except you can’t schedule these reports.
### Appendix A

#### Criteria: Dedham Incidents by Day of Week, Hour of Day

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Field</th>
<th>Operator</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>And/Or</td>
<td>Basic Incident Type (FD1.21)</td>
<td>Is Not Blank</td>
<td>E2050</td>
</tr>
<tr>
<td>and</td>
<td>Basic Fire Department ID (FD1.1)</td>
<td>Is Equal To</td>
<td>E2050</td>
</tr>
<tr>
<td>or</td>
<td>Basic Incident Day Of Week Number And Name (FD1.3)</td>
<td>Contains</td>
<td>2</td>
</tr>
<tr>
<td>or</td>
<td>Basic Incident Day Of Week Number And Name (FD1.3)</td>
<td>Contains</td>
<td>3</td>
</tr>
<tr>
<td>or</td>
<td>Basic Incident Day Of Week Number And Name (FD1.3)</td>
<td>Contains</td>
<td>4</td>
</tr>
<tr>
<td>or</td>
<td>Basic Incident Day Of Week Number And Name (FD1.3)</td>
<td>Contains</td>
<td>5</td>
</tr>
<tr>
<td>or</td>
<td>Basic Incident Day Of Week Number And Name (FD1.3)</td>
<td>Contains</td>
<td>6</td>
</tr>
<tr>
<td>and</td>
<td>Basic Incident One-Hour Range Of Day 24</td>
<td>Contains Any</td>
<td>08:00:00</td>
</tr>
<tr>
<td>or</td>
<td>Basic Incident One-Hour Range Of Day 24</td>
<td>Contains Any</td>
<td>09:00:00</td>
</tr>
<tr>
<td>or</td>
<td>Basic Incident One-Hour Range Of Day 24</td>
<td>Contains Any</td>
<td>10:00:00</td>
</tr>
<tr>
<td>or</td>
<td>Basic Incident One-Hour Range Of Day 24</td>
<td>Contains Any</td>
<td>11:00:00</td>
</tr>
<tr>
<td>or</td>
<td>Basic Incident One-Hour Range Of Day 24</td>
<td>Contains Any</td>
<td>12:00:00</td>
</tr>
<tr>
<td>or</td>
<td>Basic Incident One-Hour Range Of Day 24</td>
<td>Contains Any</td>
<td>13:00:00</td>
</tr>
<tr>
<td>or</td>
<td>Basic Incident One-Hour Range Of Day 24</td>
<td>Contains Any</td>
<td>14:00:00</td>
</tr>
<tr>
<td>or</td>
<td>Basic Incident One-Hour Range Of Day 24</td>
<td>Contains Any</td>
<td>15:00:00</td>
</tr>
<tr>
<td>or</td>
<td>Basic Incident One-Hour Range Of Day 24</td>
<td>Contains Any</td>
<td>16:00:00</td>
</tr>
</tbody>
</table>

Add New Button